# Table of Contents

Scope of this Guide ........................................................................................................................................... 1

Use Styles to Establish the Document Structure........................................................................................ 1

  What If I Don’t Like the Formatting of the Styles in Word? ............................................................................. 1

Table of Contents for Extensive Documents ...................................................................................................... 2

  Create a Table of Contents ............................................................................................................................ 2

  Update the Table of Contents ........................................................................................................................ 2

Why are Styles and a Table of Contents Important? .......................................................................................... 3

Include Text Descriptions of Images and Graphics ............................................................................................ 3

  Setting Alt Text for Images and Graphics ....................................................................................................... 3

  Caption Images and Graphics ........................................................................................................................ 4

  Tips on Writing Text Descriptions ................................................................................................................... 4

Hyperlinks.......................................................................................................................................................... 5

Allow Word to Format Bulleted and Numbered Lists .......................................................................................... 5

Make Tables as Accessible as Possible ............................................................................................................ 6

  Use the Insert Table Method .......................................................................................................................... 6

  Caption the Table ........................................................................................................................................... 6

  Add the Table Title to the Table of Contents .................................................................................................. 7

  Configure Table Properties ............................................................................................................................ 7

  Tables with Column and Row Headers .......................................................................................................... 8

Color and Contrast ............................................................................................................................................ 8

Accessibility Checker ......................................................................................................................................... 9

Preserve Accessibility When Pasting to the Web ............................................................................................. 10
**Scope of this Guide**

This guide will focus on making a Microsoft Word document accessible. To benefit the most from this guide, you should be familiar with many of the common word processing features of Microsoft Word 2010.

**Use Styles to Establish the Document Structure**

Use Styles in Word to format the text in the document. Use Heading Styles to format major sections and subsections of the document.

At least three styles should be used: **Title**, **Heading 1**, and **Heading 2**.

Use **Title Style** on the title of the document. Use **Heading 1** on the first major section of the document, and each subsequent major section of the document. Within each section use **Heading 2** for each subsection.

Simply click on the Style you wish to use and begin typing.

**What If I Don’t Like the Formatting of the Styles in Word?**

You can still use your preferred formatting, just modify the style.

1. Type the text for your heading 1, format it, and then select the text.
2. Go up to the **Styles Drawer**, right click on **Heading 1**.
3. Click on **Update Heading 1 to Match Selection**. Repeat for the remaining headings.
Table of Contents for Extensive Documents

Create a Table of Contents
Add a table of contents to the beginning of the document, especially for long documents with many sections. If you’ve used Styles for your document formatting, the table of contents is created instantly.

1. With the Insertion Point at the beginning of the document, click the Insert tab, then click on Page Break.
2. Click the References tab, then click on Table of Contents.
3. Choose from the first two options in the menu.

Update the Table of Contents
Be sure to update the table of contents before printing the document or saving it as another file type.

1. Click anywhere on the table of contents.
2. Click on the Update Table button at the top left corner of the table.
3. Select the Update entire table option.
Why are Styles and a Table of Contents Important?

Styles and a table of contents help establish the document structure for students using screen readers. Screen readers work best when the software is able to describe to the user the structure of the document in words spoken out loud. What the screen reader begins to read aloud first will depend on how you have set up the document. If you haven’t used Styles or haven’t included a table of contents, then the screen reader will simply start reading every word on the page from the top to the bottom.

By using Styles and a table of contents, the screen reader will describe the document structure and then allow the student to jump to a particular section of the document.

Include Text Descriptions of Images and Graphics

All images and graphics should include a description called Alt Text. Also, provide a caption for all images and graphics.

Setting Alt Text for Images and Graphics

For any image or graphic within the document, be sure to include Alt Text, a text based description of the image or graphic. The screen reader will read aloud the Alt Text for each image or graphic.

1. Right click on the image or graphic.
2. Click on the Format Picture menu item.
3. In the Format Picture window, click on Alt Text in the column on the left.
4. In the Description box, type in the image or graphic text description.
**Caption Images and Graphics**

Captions are similar to Alt Text, but captions are visible in the document, appearing either above or below the object.

1. Right click on the image or graphic.
2. Click on the **Insert Caption** menu item.
3. In the **Caption** window, type the image or graphic caption in the **Caption** box.

**Tips on Writing Text Descriptions**

Be as concise and accurate as possible, conveying in written words the function and content of the image or graphic. Avoid repeating the same information that may be found elsewhere near the image. For instance, if there is a lengthy discussion of the image, don’t copy and paste all of that into the Description box.

Also, don’t use the terms graphic or image in describing the object, unless the medium is important in conveying the meaning of the image.
Hyperlinks

Create hyperlinks with Display Text and avoid simply pasting in lengthy web addresses.

1. Type the Display Text and highlight the text.
2. Right click on the text and click on the Hyperlink menu item.
3. In the Insert Hyperlink window, paste in the link address in the Address field.

If the document will be printed, include the entire hyperlink, but place it in parentheses.

Accessibility Technology Initiative (http://web.calstatela.edu/academic/aa/cetl/r/ati.php)

Allow Word to Format Bulleted and Numbered Lists

Use the Bulleted List and Numbered List function in Word to create lists. This will ensure the list adheres to a structure discernable by a screen reader or other device. Place a period at the end of each list item to indicate the end of the list item.
Make Tables as Accessible as Possible

Tables can be especially problematic and it’s best to avoid them if possible. But for times when tables are absolutely necessary, be sure to make the table as accessible as possible.

Use the Insert Table Method
1. Click on the **Insert** tab.
2. Find and click on the **Table** option.
3. Move the mouse over the tiny squares to select the number of columns and rows.

Caption the Table
1. Right click on the table handle at the top right corner of the table.
2. Click on the **Insert Caption** menu item.
3. In the **Caption** window, change the **Label** type to **Table** and write the caption after “Table…”
Add the Table Title to the Table of Contents

1. Select the table title.
2. Click on the References tab.
3. Click on Add Text.
4. Select from levels 1 through 3 depending on the location of the table within the document.

Configure Table Properties

1. After selecting the first row of the table, right click on the table.
2. Click on the Table Properties menu item.
3. Click on the Row tab.
4. Uncheck Allow row to break across pages.
5. Check Repeat as header row at the top of each page.
6. Click on the Alt Text tab and provide a text description for the table.
Tables with Column and Row Headers
Currently, Word doesn’t provide a way to mark the first column as a header. This means that a screen reader won’t know that the first column contains labels for the data presented in the adjacent columns.

To make an accessible table with both column and row headers, you’ll need to use Adobe Acrobat Professional. You’ll still create your document in Word, but you’ll need to save it as a PDF and configure the table for accessibility in Acrobat. For more information on Adobe Acrobat Professional, please refer to the Adobe Acrobat Accessibility Guide.

Color and Contrast
Using color in your documents is fine, but make sure when reproduced in grayscale, there is sufficient contrast between items.

<table>
<thead>
<tr>
<th>Red</th>
<th>Red</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Green</td>
</tr>
<tr>
<td>Blue</td>
<td>Blue</td>
</tr>
<tr>
<td>Cyan</td>
<td>Cyan</td>
</tr>
<tr>
<td>Magenta</td>
<td>Magenta</td>
</tr>
<tr>
<td>Yellow</td>
<td>Yellow</td>
</tr>
<tr>
<td>Black</td>
<td>Black</td>
</tr>
<tr>
<td>Gray</td>
<td>Gray</td>
</tr>
</tbody>
</table>

If color is the only distinguishing characteristic between two or more items, then consider using another method. To differentiate text, consider size, bold, and italics. For line graphs, use dotted or dashed lines.

Exercise caution when presenting colored text with a colored background. Sufficient contrast must exist between the text and the background.
Use the Accessibility Checker to scan the document for missing descriptive text for images or graphics.

1. Click on **File** making sure to stay in the **Info** section.
2. Click on **Check for Issues** and select **Check Accessibility**.

Although Word provides an accessibility checker, avoid relying on it too extensively. The checker mainly looks for missing Alt Text and whether tables contain a repeating header row. The checker will not alert you if you have forgotten to use Styles, failed to include a table of contents, improperly formatted hyperlinks or used manually created lists.
Preserve Accessibility When Pasting to the Web

If you’ve gone to all the trouble of using styles in Word, then ensure that when the text is pasted into Moodle, the styles and heading structure are preserved. The Moodle text editor allows you to paste text directly from Word while preserving the headings. Check that it has been preserved by using the Path info bar at the bottom of the text editor.

1. Click on one of the headings.
2. Check the Path info bar.

This heading in Word used the heading 1 style. Notice that the Path info bar indicates that it uses h1, the HTML tag for heading 1. Click on the next heading, the Path info bar would indicate h2 or heading 2.

If the heading styles are lost, use the text editor to restyle the text. Please see the Accessible Moodle Content Guide for more information on editing text in the Moodle text editor.

Preserve Accessibility When Creating a PDF

When saving the document as a PDF, be sure to use the Adobe Acrobat PDF plug-in to create the PDF.

Although newer versions of Office do allow you to use the Save As command, some formatting critical to accessibility is lost in the conversion to PDF.